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Abstract

Conventional imaging techniques can provide detailed information about cellular processes. However, this information is based on static images
in an otherwise dynamic system, and successive phases are easily overlooked or misinterpreted. Live-cell imaging and time-lapse microscopy,
in which living cells can be followed for hours or even days in a more or less continuous fashion, are therefore very informative. The protocol
described here allows for the investigation of the fate of chemotherapeutic nanoparticles after the delivery of doxorubicin (dox) in living cells.
Dox is an intercalating agent that must be released from its nanocarrier to become biologically active. In spite of its clinical registration for more
than two decades, its uptake, breakdown, and drug release are still not fully understood. This article explores the hypothesis that lipid-based
nanoparticles are taken up by the tumor cells and are slowly degraded. Released dox is then translocated to the nucleus. To prevent fixation
artifacts, live-cell imaging and time-lapse microscopy, described in this experimental procedure, can be applied.

Video Link

The video component of this article can be found at https://www.jove.com/video/55405/

Introduction

The ability to follow a biological process, such as cell-cell interactions, inter- and intracellular transport, cytotoxic compound uptake, and
protein-protein interaction of single molecules in living cells and tissues, has gained great interest over the last decade, as it provides the extra
dimension of "real time." In this manuscript, a method to follow the intracellular fate of free dox and dox incorporated in nanoparticles (Dox-NP) is
described.

Nanoparticles have been used for decades to treat certain cancers. Dox-NP has been approved for the treatment of AIDS-related Kaposi
sarcoma, advanced ovarian and breast cancer, and multiple myeloma1. It was one of the first liposomal nanoparticles developed and introduced
in the clinical setting. The free form, dox, is vastly cleared from the blood circulation, limiting its capacity to reach the tumor site in sufficient
amounts. Furthermore, treatment is accompanied by severe and dose-limiting side-effects, such as stomatitis and heart failure. When
encapsulated into pegylated liposomal nanoparticles the circulation time increases from minutes to days2. This type of cholesterol-containing
liposome is quite stable and this stability determines the pharmacokinetics of encapsulated drug.

However, this rigidity has a downside. The cytotoxic ability of a compound towards tumor cells is first evaluated in vitro, and it has been
shown that dox is more potent than Dox-NP in cytotoxic assays3,4. It was hypothesized that the stability of the carrier prevents the release
and cellular uptake of the drug, and it is worthwhile to investigate this phenomenon further. The intrinsic liposomal properties, built to last the
aggressive elements in the blood stream and to reach the tumor site intact, resulted in the impaired bioavailability of the cytotoxic component
(i.e., dox) at the target site (i.e., the tumor cell nucleus). Although Dox-NP hardily improved the response compared to the free form, it was still
of clinical value, as encapsulation significantly reduced the cardiotoxic effects5. In the following years, other compounds were encapsulated
in nano-carriers6. Also, modifying the carriers resulted in triggered drug release (i.e., at the tumor site) but maintained stability in the blood
circulation7,8. Despite years of investigation and clinical use, the intratumoral fates of nanocarriers like Dox-NP are still not entirely clear. In a
recent publication, it was shown that the nanoparticle is taken up as a whole while the dox remains trapped in the lysosomes9.

Cellular uptake of a nanoparticle and drug release are dynamic processes that can best be monitored using live-cell imaging. Moreover, classical
histology, in which cells are incubated and thereafter fixed, can give false results if the fixation destroys the liposomal carrier and introduces
artifacts. The main requirement for live-cell imaging is visualization, preferably by fluorescence, of the desired process. Certain compounds, like
dox, have an intrinsic red fluorescence. Also, fluorescent markers can be introduced into the carrier, and cell organelles can be visualized using
live-cell markers. In this way, an array of parameters, like uptake of the carrier, drug release, and cellular localization of the carrier and drug,
can be imaged and analyzed. Here, a method is described in which the intercellular fate of dox and Dox-NP in several tumor cells is followed in
real-time. Also, this method can be easily adapted to create the ideal conditions for targeted (e.g., charged nanoparticles10) and triggered (e.g.,
hyperthermia7) drug release.
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Protocol

1. Preparation

1. Assemble the imaging chamber, which consists of two parts.
1. Place a 25-mm cover glass (Figure 1A-1) at the bottom part of the chamber (Figure 1A-2) and screw the top part into the bottom part

(Figure 1A-3). Do not tighten too hard, as the glass can break. Autoclave the entire chamber (Figure 1A-4).

2. Prepare cell culture medium by supplementing Dulbecco's Modified Eagle's Medium (DMEM) without phenol red with 10% heat-inactivated
fetal calf serum (FCS) and 1 mM L-glutamine under sterile conditions. Store at 4 °C and warm to 37 °C before use.

3. Maintain the cells with cell culture medium in culturing flasks using standard cell culture techniques.
 

NOTE: Here, two mouse cell lines, melanoma B16BL611 and Lewis lung carcinoma (LLC), and two human melanomas, BLM and 1F612, were
used.

4. Make 0.1% gelatin by weighing and dissolving gelatin in phosphate-buffered saline (PBS) at 37 °C overnight. Sterilize the solution by filtering
it through a 0.22-µm filter and store it at 4 °C.

2. Plate Cells

1. Remove the imaging chamber from the sterilization bag in a laminar flow cabinet, carefully tighten the chamber, and place it in a petri dish.
 

NOTE: To avoid contamination, keep the imaging chamber in a petri dish until the chamber can be placed under the microscope.
2. Coat the glass of the imaging chamber with 1 mL of 0.1% sterile gelatin for 20 min at 37 °C and 5% CO2.

 

NOTE: This will allow better cell attachment.
3. Remove the medium from the cell culture flasks (see steps 1.2 and 1.3), wash once with 1x PBS, and detach the cells using 0.25% trypsin.

Inactivate the trypsin by adding cell culture medium, collect the cells, spin them down at 1,100 x g for 5 min, and resuspend the pellet in 5 mL
of cell culture medium.

4. Dilute 20 µL of cell suspension with 20 µL of trypan blue (which will be taken up by dead cells). Count the number of living and dead cells
using a hemocytometer; the number of dead cells should not exceed 10%.

5. Aspirate the gelatin and plate the cells in a dilution that allows for a maximum of 70% coverage within 24 h. For example, use a dilution of 5 x
104 or 10 x 104 cells in 1 mL. Allow the cells to adhere at 5% CO2 and 37 °C for 24 h.

3. Time-lapse Microscopy (Figure 2)

NOTE: Here, a confocal microscope with a custom-made stage holder was used, although most manufactures offer a range of incubators for
live-cell imaging that are also suitable to investigate nanoparticulated drug delivery.

1. Evaluate the cells under a microscope for confluency, cellular morphology, and contamination. Place the chamber back in the CO2 incubator.
 

NOTE: The confluency should not exceed 70%. If the cellular morphology is inconsistent (i.e., the cells do not adhere) or contamination is
detected, discard the imaging chamber.

2. Switch on the confocal microscope (Figure 1E-1), fluorescent light (Figure 1E-2), and computer (Figure 1E-3).
3. Connect the lens heater to the objective and set it to 35 °C (Figure 1E-4 + insert).
4. Prepare the incubation unit, as shown in Figure 1B.

 

NOTE: This unit consists of a heated stage (Figure 1B-1), a flow stage with a connector for the CO2 tubes (Figure 1B-2) and CO2 probe
(Figure 1B-3), and a red closing patch (Figure 1B-4). This patch is used to temporarily close the unit until the imaging chamber is placed.

5. Place the incubation unit on the microscope stage and connect the in- and out-flow CO2 tubes (Figure 1E-5). Open the main CO2 valve
(Figure 1E-6) and switch on the CO2 controller (Figure 1E-7). Check that the controller is set to 5% CO2.
 

NOTE: For humidity, CO2 passes through a humidifier (Figure 1E-8). For hypoxia experiments, a separate O2 regulator (Figure 1E-9) is
included in the setup.

6. Set the stage temperature to 37 °C (Figure 1E-10). For hyperthermia experiments, set the temperature to 42 °C. Allow the incubation unit to
reach the selected temperature and CO2 percentage.

7. Take the imaging chamber from the main CO2 incubator and transport the chamber in a petri dish to the microscopy room.
8. Place the imaging chamber (Figure 1A-4) in a custom-made, 35 mm-diameter stage holder (Figure 1A-5) and close the chamber with

a custom-made sealing lid (Figure 1A-6).
 

NOTE: The lid allows CO2 to pass and prevents evaporation and contamination.
1. Open the incubation unit, replace the red patch with the imaging chamber, and close the unit (Figure 1C). Do this as fast as possible to

prevent the cooling down of the cells. Make sure that no cables are stuck between stage and the microscope.

9. Leave the unit to acclimatize for 30 min.
10. Open the software and switch on the lasers.

 

NOTE: Here, 488 nm argon, 543 nm helium-neon, and 633-nm helium-neon lasers were used.
11. Make a new database by clicking "New" under the File tab. Name and save the database.
12. Set the configuration by clicking "Config" under the Acquire tab. Select "Channel mode" and "Single track" to evaluate a single fluorophore or

"Multi track" for several fluorophores. Select the appropriate band-pass filters matching the fluorophore (e.g., 560 to 615 nm band-pass filter
for dox and Dox-NP; see the Representative Results for more examples). Select the bright-field channel in one of the tracks.

13. Set the scan control by clicking "Scan" under the Acquire tab. Set the frame size (1,024 x 1,024), scan speed (optimal), scan direction (8-bit,
single), and scan average (4) by clicking "Mode." Set the pinhole (200 µm), gain and offset (e.g., 580, 700, and 835; see Figure 3), and laser
power (488 = 10%, 543 = 100%, 633 = 100%) by clicking "Channels."

https://www.jove.com
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14. Save these settings by clicking "Config" in the Configuration tab and save them in the configuration database.
15. Set the time-lapse by clicking "Multi Time X" (Figure 1D) in the Macro tab. Click "Single location".
16. To keep the cells in focus, select the automated focus in the macro by clicking "Auto Focus."

 

NOTE: Autofocus is achieved with the 633-nm laser using the reflection of the glass as a reference point.
17. Apply the saved configuration by clicking "Single track" or "Multi track," scrolling to the required configuration in the configuration database,

setting the time interval (e.g., 15 min), number of scans (e.g., 97) and clicking "Load Config."
 

Note: Using these settings, a time-series of 97 x 15 min = 24 h will be made.
18. Name the time-lapse in the "Base File Name" and select the database (made in step 3.11) by clicking "Image Data Base" to save the time-

lapse. Set a temporary folder by clicking "Tmp Image Folder."
 

NOTE: If the system stops or crashes for any reason, the images are located in this folder.
19. Open the incubating unit, lift the imaging ring, add a drop of immersion oil to the objective, and close the unit as fast as possible. Focus and

select a position in the imaging chamber.
 

NOTE: This position contains cells in a monolayer, with a minimum of 70% confluency, allowing for the imaging of individual cells.
20. Check the configuration settings for the background and correct if necessary.

 

NOTE: The background can be corrected by reducing the gain or laser power. Any change in the configuration needs to be saved (see step
3.17) and loaded (see step 3.18) again in the macro.

21. In the laminar flow cabinet, dilute free drug or nanoparticles at a concentration of 5 µg/mL drug or 0.05 µmol of lipids in cell culture medium.
Filter through a 0.22-µm syringe filter if the drug/nanoparticles are not sterile.

22. Open the incubating chamber, lift the sealing lid, remove the medium from the cells, add 1 mL of diluted drug/nanoparticles, and close the unit
as fast as possible.

23. Focus on the cells and start the time-lapse by clicking "Start Time" in the Multi Time X macro.
24. Check regularly to see if the cells are still in focus or use the autofocus (see step 3.16). The program automatically saves the time-lapse in

the database; do not close the database while the program is running.

4. Data Analysis

1. Depending on the original research question, use software programs such as ImageJ for data analysis (see the Results section for
examples).

Representative Results

Labeling liposomal carriers with different markers has been previously described9. Carriers labeled with far-red dioctadecyl
tetramethylindotricarbocyanine perchlorate (DiD; Ex = 644 nm; Em = 665 nm) or green 1,2-dioleoyl-sn-glycero-3-phosphoethanolamine-N-
(carboxyfluorescein) (CF-PE; Ex = 490 nm; Em = 515 nm) are presented in this manuscript. To show intercellular similarities and differences
in liposomal uptake, release, and intracellular localization, several tumor types were studied. These include two mouse lines, the B16BL6
melanoma11 and the Lewis lung carcinoma (LLC), and two human melanomas, a highly metastatic (BLM) and a non-metastatic (1F6)
melanoma12,13. All experiments were performed using living cells. In all experiments, a concentration of 5 µg/mL dox, 5 µg/mL Dox-NP, or 0.05
µmol of nanoparticles were administered for 3 or 24 h. Measured and analyzed dox (in free, released, encapsulated, sequestered, or intercalated
form) were referred to as DXR. A 40X (numerical aperture: 1.3) oil objective lens was used, and imaging was performed with a 488 nm argon
laser (10%/0.2 mW power) and a 505 to 550 nm band-pass filter for CF-PE and lysosomal marker (LM)-green. A 543 nm helium-neon laser
(100%/ 0.2 mW power) and a 560 to 615 nm band-pass filter was used for dox, Dox-NP, and lysosomal marker-red. A 633 nm helium-neon laser
(100%/0.5 mW power) and a 640 nm long-pass filter was used for DiD.

Because of its encapsulation, the in vitro cytotoxicity, bioavailability, and pharmacokinetics of dox were significantly altered3,9,14. The difference
between the bioavailability of the drug when administered in free and encapsulated form is demonstrated in Figure 3. Dox is an intercalating
agent and must enter the cell nucleus to become cytotoxic. Figure 3 and related Movies 1 and 2 show a 3 h time-lapse of BLM cells treated with
dox or Dox-NP under identical conditions. Within minutes of dox exposure, nuclear DXR can be observed (Figure 3A, Movie 1) and, using a
lower gain (insert), can be seen intercalating in the nucleus. In contrast, when exposed to Dox-NP, intracellular DXR is hardly visible within this
time-frame (Figure 3B, Movie 2). Only by increasing the photomultiplier gain, DXR in the cytoplasm can be observed (insert). Using ImageJ, the
pixel densities of cytoplasmic and nuclear DXR were analyzed. As cells are in motion during time-lapse evaluation, it is important to combine
fluorescent with bright-field images. This presents the possibility of tracking individual cells and stabilizing the XY-drift using specific plugins in
ImageJ. In the analysis presented in Figure 3, the bright-field image was used to draw a region of interest (ROI) around the cytoplasm (solid
line) and nucleus (dotted line). The ROI manager in ImageJ can be found in the menu item Analyze > Tools > ROI manager. These ROIs are
used in the fluorescent image to analyze pixel density by using the menu item Analyze > Measure. The difference between the pixel density
in the nucleus (Figure 3C) and cytoplasm (Figure 3D) of dox- or Dox-NP-treated cells confirms what is seen in the images. Also, cells were
incubated for 24 h with dox or Dox-NP, after which the compound was replaced by medium and immediately imaged with increased sensitivity of
the photomultiplier gain (Figure 4). Other settings, such as laser power, offset, pinhole, and image display, were identical. The low DXR signal
in Dox-NP-treated compared to dox-treated cells is striking. Using a gain of 700, DXR in the Dox-NP-treated cells becomes visible, whereas
the image of dox is already overexposed. This simple in vitro experiment visualizes a significant difference in the bioavailability of free versus
encapsulated drug.

When cells are continuously exposed to Dox-NP for 24 h, DXR builds up over time, as shown in Figure 5A and Movies 3 and 4. The signal
increases in the cytoplasm, and later, DXR is also found intercalated in the nucleus. These observations are confirmed by the pixel density
graphs (Figure 5B). The measured cytoplasmic pixel density is lower in BLM compared to 1F6 cells because of the difference in intracellular
distribution. Whereas DXR in 1F6 cells is distributed throughout the cell, DXR in BLM cells is more concentrated in an organelle close to the
nucleus (Figure 5C).

https://www.jove.com
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Therefore, the localization of drug and carrier in different cell lines (Figure 6) was investigated. Cells were incubated for 24 h with Dox-NP/DiD
and imaged. Using the bright-field image, an overlay of the cell membrane (solid line) and nucleus (dotted line) was drawn in the fluorescent
image of three different cell lines. It is demonstrated here that the carrier, labeled with DiD, follows the same cytoplasmic pattern as DXR:
concentrated in an organelle close to the nucleus in BLM, around the entire nucleus in LLC, and randomly scattered throughout the cytoplasm in
B16BL6 cells. In the nucleus, only DXR and no DiD can be seen, indicating released dox. By reducing the photomultiplier gain, individual cellular
vesicles containing DXR and carrier, labelled with DiD, as well as with CF-PE (Figures 6B and 6C), can be seen.

Cytoplasmic DXR sequesters in small vesicles, and cells were labeled with a live-cell lysosomal marker in green or red. The movement of these
lysosomes can be followed in the cells (Movie 5). Cytoplasmic DXR and the nanocarrier colocalize within these structures, and the intercellular
difference in the DXR pattern, as seen in Figure 6, is explained here. Lysosomes are randomly distributed throughout the cytoplasm in B16BL6
and are located next to the nucleus in BLM cells (Figure 7A). Using ImageJ, the colocalization between DXR and carrier in the lysosome was
calculated (Figure 7B). The color images were made binary (Process > Binary > Make Binary) and, using the colocalization plug-in (Analyze >
Colocalization), a colocalization image was made of DXR with DiD. This creates a green-red-white colored image, with white pixels representing
the colocalized pixels of both images. Via the menu item Process > Binary > Make Binary, the white pixels will be separated and converted
to black pixels, from which the pixel density is measured (Analyze > Measure). Thereafter, a colocalization image was made between this
DXR-DiD image and the binary image of the lysosomal marker (LM) and pixel density measured. The colocalization data is the percentage of
pixels positive for DXR-DiD and DXR-DiD/lysosomal marker (Figure 7C). That the carrier, labeled with CF-PE as well as DiD, is located in the
lysosome is also shown in Figure 7D.

 

Figure 1: Instruments and equipment setup. A) Imaging chamber + necessities. 25-mm #1 cover glass (1), bottom part of the chamber (2),
top part of the chamber (placed upside down) and O-ring (3), stage holder (4), and sealing lid (5). Scale bar: 2 cm. B) Incubation unit. Heated
microscope stage (1), flow stage with in- and out-flow for CO2 (2), a CO2 probe (3), and a closing patch (4). Scale bar: 2 cm. C) Imaging chamber
in the incubator unit, as seen under the microscope. D) Multi-time series macro. E) Equipment for imaging. Inverted microscope (1), fluorescent
light (2), computer (3), ring heater (4, insert) and controller (4, main figure), CO2 flow tubing (5), CO2 valve (6), CO2 controller (7), CO2 humidifier
(8), O2 valve and controller (9), and stage temperature controller (10). Please click here to view a larger version of this figure.
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Figure 2: Schematic of the microscope parameters detailed in Protocol section 3. Please click here to view a larger version of this figure.

 

Figure 3: Investigating the short-term uptake of dox and Dox-NP.  BLM cells were continuously exposed to dox or Dox-NP for 3 h, and
a time-lapse was taken. (A) Still pictures of the time-lapse of cells incubated with dox. (B) Still pictures of the time-lapse of cells incubated
with Dox-NP. Scale bar = 50 µm. (C) Pixel density increase of nuclear DXR in dox- and Dox-NP-treated cells. (D) Pixel density increase of
cytoplasmic DXR in dox- and Dox-NP-treated cells. The data represent the mean ± SD of 3 cells per field. Please click here to view a larger
version of this figure.
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Figure 4: Investigating the long-term uptake of dox and Dox-NP in different cell lines. Cells were exposed to dox or Dox-NP and imaged
24 h later. Images were taken immediately after the removal of the drugs, with 3 different gains. Scale bar = 50 µm. Please click here to view a
larger version of this figure.

 

Figure 5: Investigating the cellular uptake and release of liposomal agents. Cells were continuously exposed to Dox-NP for 24 h, and a
time-lapse was made. (A) Still pictures of the time-lapse. Scale bar = 50 µm. (B) Pixel density increase of DXR in the nucleus and cytoplasm.
The data represent the mean ± SD of 3 cells per field. (C) Images demonstrating the localization of DXR within the cell. Solid line: cell
membrane, dotted line: nucleus. Please click here to view a larger version of this figure.
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Figure 6: Investigating the localization of drug and carrier in different cell lines. (A) Cells were exposed to Dox-NP/DiD for 24 h and
imaged. Scale bar = 50 µm. (B) Cells were exposed to Dox-NP/DiD/CF-PE for 24 h and imaged with a lower intensity gain to distinguish
individual vesicles. (C) Bright-field and DXR overlay showing DXR in cytoplasmic vesicles (arrow). Please click here to view a larger version of
this figure.

https://www.jove.com
https://www.jove.com
https://www.jove.com
http://ecsource.jove.com/files/ftp_upload/55405/55405fig6large.jpg
http://ecsource.jove.com/files/ftp_upload/55405/55405fig6large.jpg


Journal of Visualized Experiments www.jove.com

Copyright © 2017  Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

November 2017 |  129  | e55405 | Page 8 of 12

 

Figure 7: Investigation of the intracellular localization of the drug and carrier. Cells were exposed to Dox-NP/DiD or CF-PE/DiD for 24 h,
and lysosomes are visualized using the live-cell lysosomal marker (LM) in green or red. (A) Intracellular localization of DXR and the carrier (DiD).
The arrows represent 3 examples of DXR and DiD localized in the lysosome. Scale bar = 50 µm. (B) Co-localization analysis of DXR and the
carrier (DiD) in lysosomes (LM) using ImageJ. (C) Percentage of co-localization of DXR and the carrier in lysosomes. The data represent the
mean ± SEM of 3 individual experiments. (D) Lysosomal sequestering of the carrier visualized using two different markers. Scale bar = 50 µm.
Please click here to view a larger version of this figure.
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Movie 1: Related to Figure 3: BLM cells were incubated with dox for 3 h. Time-lapse: 19 images, with an interval of 10 min. Frame rate: 3
fps. Scale bar = 50 µm. Please click here to view this video. (Right-click to download.)

 

Movie 2: Related to Figure 3: BLM cells were incubated with Dox-NP for 3 h. Time-lapse: 19 images, with an interval of 10 min. Frame rate:
3 fps. Scale bar = 50 µm. Please click here to view this video. (Right-click to download.)
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Movie 3: Related to Figure 5: BLM cells were incubated with Dox-NP for 24 h. Time-lapse: 96 images, with an interval of 15 min. Frame rate:
8 fps. Scale bar = 50 µm. Please click here to view this video. (Right-click to download.)

 

Movie 4: Related to Figure 5: 1F6 cells were incubated with Dox-NP for 24 h. Time-lapse: 96 images, with an interval of 15 min. Frame rate:
8 fps. Scale bar = 50 µm. Please click here to view this video. (Right-click to download.)
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Movie 5: Related to Figure 7: Lysosomes of B16BL6 cells were stained with a live-cell marker. Time-lapse: 10 images, with an interval of
10 s. Frame rate: 3fps. Scale bar = 50 µm. Please click here to view this video. (Right-click to download.)

Discussion

As observed in the past, fixation can destroy liposomal nanocarriers almost immediately and DXR released form these destroyed liposomes
still had the time to enter the nucleus, making the interpretation of data very difficult and even misleading. With some microscopic adjustments,
the chemotherapeutic fate in living cells and tissues can be routinely investigated to confirm or overthrow histological observations. A recent
paper showed the uptake, release, and localization of DXR in cells treated with free and encapsulated dox using live-cell time-lapse imaging9.
This work describes the experimental setup in more detail. Using this model, it is possible to visualize the immediate transportation of dox to
the nucleus, where it continuously accumulates until the cell eventually dies. In contrast, when Dox-NP is used, only small amounts of released
dox are found in the nucleus. Although continuous exposure results in continuous DXR buildup, the fluorescent signal is much lower in Dox-NP-
versus dox-treated cells, indicating a difference in cellular concentration and subsequent cytotoxicity. Furthermore, by using live-cell markers,
it was shown that, when exposing cells to Dox-NP, DXR and the nanocarrier are located in the lysosome. This indicates that the complete
liposome is taken up by the cell and demonstrates the involvement of an endocytic pathway during the uptake of these nanoparticles. The DXR
in the nucleus is clearly from released dox. However, using this method, as both the DXR and carrier co-localize and seem to be entrapped in
lysosomes, it is still inconclusive whether this is encapsulated or released dox. It is possible that the intrinsic stability of the nanoparticle prevents
dox release when localized in the lysosome.

In this protocol, live-cell imaging is demonstrated using a specific microscopic setup, with a custom-made stage holder (the specifications can
be given on request). However, most confocal microscope manufactures offer a range of incubators that perform live-cell imaging. Preserving
cell culture conditions (i.e., temperature, CO2, pH, humidity, and sterility) is the main criterion of these incubators and requires some preliminary
testing to determine the proper conditions, which is further explained. Automated data acquisition programs can also be delivered by the same
manufactures. A "Multi location" option makes it possible to image several positions in the same chamber, refining statistical analysis. However,
this option in the macro mentioned in this manuscript requires fixed XYZ positions, by which the possibility to correct for Z-drift is lost. Scanning
the Z-dimension can be included in this macro and uses a focus plane for the analysis. However, this requires extra scanning, increasing the
possibility of phototoxicity and bleaching.

As with all fluorescent measurements, overexposure is a problem, especially when comparing two compounds with a different cellular uptake.
The fluorescent intensity is not only dependent upon the intrinsic signal of the compound, but also upon the rate of uptake, the concentration,
and the drug exposure time. As shown in Figure 3, the nuclear DXR content of dox-treated cells is already visible, whereas no signal is seen in
Dox-NP-treated cells. Only by increasing the gain can the DXR in Dox-NP-treated cells be visualized, leading to overexposure in dox-treated
cells. Moreover, even intracellularly, Dox-NP is heterogeneously distributed, which can result in unavoidable under- or overexposure. Especially
when investigating the cellular DXR entrapment, the gain was reduced significantly to distinguish individual organelles (Figures 5B and 5C).
Thus, the measurements represented by pixel density must be accompanied by the representative images for the proper interpretation of results.

Phototoxicity, bleaching, and a low signal-to-noise ratio are also important issues in fluorescent microscopy, and a compromise between the
quality of the image and the image acquisition must be established. However, even when the microscope setup is optimal, the image quality
is also largely determined by the quality of the cells and the added compound. DXR gives a strong signal and, with the proper precautions,
bleaching was not observed, even after longer periods (up to 72 h). However, the reduction of the fluorescent signal can also be a result of
efflux. Efflux is an important phenomenon in drug resistance15 and occurs when cells pump out the drug from the intracellular site of action. A
decrease of the fluorescent signal over time can therefore also be a result of dox efflux9. Comparing the fluorescent signal of a non-scanned
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location at the end of the experiment with the last image from the time-lapse series will demonstrate bleaching (i.e., the signal will be higher in
the non-scanned location) or efflux (i.e., both signals will be identical). Several correctional options (e.g., background, drift, bleaching, etc.) are
available in programs like ImageJ16. Also, as the fluorescent intensity increases over time, the configuration settings can be pre-evaluated in a
pilot experiment to minimize overexposure at the end of the time-lapse (step 3.21). Alternatively, an imaging chamber with cells already exposed
to the drug for the desired time-period can be used to initialize the settings. Finally, for this type of analysis, toxic drug concentrations (step 3.22)
should be avoided and pre-established using conventional bio-assays.

Cells are continuously cultured and maintained in medium without phenol red. Phenol red fluoresces in the red part of the spectrum and can be
observed in cellular organelles, most likely lysosomes, presenting false-positive information (step 1.2). To allow for the monitoring of individual
cells, cell confluence should not exceed 70% (step 3.1.). The CO2 flow-speed (step 3.5) needs to be regulated in a validation experiment when
the equipment is purchased or after maintenance. When the speed is too high, medium will evaporate. When the speed is too low, the pH of the
medium will increase, which can affect cell growth. As the medium is without the phenol red pH indicator changes in pH cannot be observed and
are therefore easily overlooked. Once the CO2 flow is validated, these settings can be used in all future experiments.

Using the method described here, the fate of nanoparticles can easily be investigated using live-cell imaging and time-lapse microscopy. In this
procedure, commercially available nanoparticles were used. However, the fate of thermosensitive17, cationic liposomes10; liposomes enriched
with short-chain shingolipids18; and nanoparticles encapsulating other drugs8,19 were also investigated in this manner in tumor and normal cells.
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